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Interfaccia audio e superficie di controllo

Funzioni dell’interfaccia audio e della superficie di controllo

Questa sezione illustra come collegare l’unità a un computer e come usare le funzioni 
dell’interfaccia audio e della superficie di controllo di R24 con un software DAW o altro 
software .

 Funzioni  del la superf icie di 
controllo

Le funzioni incorporate della superficie di 
controllo possono essere usate per contr-
ollare il software DAW del vostro comput-
er tramite USB. Sono possibili operazioni 
di trasporto, compresa la riproduzione, la 
registrazione e lo stop, e il controllo fisico 
dei fader DAW. Inoltre, si possono map-
pare altre funzioni software DAW coi tasti 
F1~F5. (Le funzioni dipendono dal soft-
ware DAW usato.).

software DAW 
Cubase LE, ecc.

Windows/Mac

Cavo USB

R24

jack [PHONES]
Apparecchio per la 
riproduzione come cuffie 
o sistema audio

jack [OUTPUT] 
Sistema stereo,diffusori 
con amplificatori 
incorporati, ecc.

jack [INPUT 1-8] 
Chitarre e altri strumenti 
musicali, microfoni
stereo interni

driver audio 

 Interfaccia audio

R24 ha vari ingressi e uscite e può fungere 
da interfaccia audio Hi-Speed USB (USB 
2.0) con 8 ingressi e 2 uscite, con una 
qualità che raggiunge i 24-bit/96 kHz. Gli 
effetti possono essere usati se la frequen-
za di campionamento è pari a  44.1 kHz, e 
l'unità può essere alimentata dall'USB bus 
del computer.
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 Accordatore multifunzione

In aggiunta all’accordatura cromatica 
standard, l’accordatore multifunzione 
incorporato supporta chitarra a 7-corde, 
basso a 5 corde e varie accordature 
particolari

 Completo mixer incorporato

Usando il mixer di R24, potete fare un mix 
per monitorare. Registrando contempo-
raneamente chitarra e voci, ad esempio, 
potete regolare il bilanciamento di volume, 
pan e riverbero.
Inoltre, potete anche regolare il bilancia-
mento tra mixer incorporato e il suono 
inviato da un computer.

 Funzioni effetto versatili

Gli effetti insert incorporati sono applica-
bili a specifici percorsi canale, e due tipi 
di effetto send/return lavorano tramite il 
mixer send/return. Questi effetti possono 
essere applicati durante la registrazione, 
naturalmente, ma possono anche essere 
applicati alla sola uscita monitor. 
Ad esempio, registrando le voci, potete 
applicare un riverbero al segnale monitor 
soltanto, per facilitare il cantato.

 Supporto per ingressi di varie 
fonti, comprese chitarre, microfoni e 
strumenti in linea

Gli 8 jack incorporati, che accettano con-
nettori XLR e standard, comprendono un 
ingresso ad alta impedenza e due per ali-
mentazione phantom (24V or 48V). 
Si possono supportare molte fonti, da 
chitarre e bassi ad alta impedenza a 
microfoni dinamici o a condensatore e 
apparecchiature in linea come synth.  
Inoltre,  i  microfoni  a condensatore 
dalle grandi performance sono utili per 
registrare la chitarra acustica e le voci.
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R24 interfaccia audio: requisiti di sistema 

Fate riferimento alla guida all'avvio di Cubase 
LE per istruzioni dettagliate per installare i 
driver audio di R16/R24 e Cubase LE.

R24 Interfaccia audio: requisiti di 
sistema 

Cubase LE: guida all’installazione

Windows
Windows® 7 (32-bit, 64-bit) o successivi
32-bit: Intel® Pentium® 4 1.8 GHz o maggiore 
64-bit: Intel® Pentium® Dual Core 2.7 GHz o mag-
giore 
32-bit: RAM 1 GB o maggiore 
64-bit: RAM 2 GB o maggiore 

Intel Mac
OS X 10.9 o successivi
Intel® Core Duo 1.83 GHz o maggiore
RAM 1 GB o maggiore 

Entrambi
Porta compatibile USB 2.0

• Hub USB non supportati.
• Consigliati chipset Intel® . 

Nota relativa a descrizioni e immagini
Questo manuale è stato preparato sulla base 
dell'uso dei sistemi Windows. Funzioni specifiche 
relative a Mac OS X sono indicate separatamente. 

Le schermate si riferiscono alla versione per  Win-
dows.

I marchi registrati

• I simboli SD  e  SDHC sono marchi registrati. 
• Windows®,  e Windows 7® sono marchi registrati di Microsoft® in USA. 
• Macintosh® eMac OS® sono marchi registrati di Apple Inc. 
• Steinberg e Cubase sono marchi registrati di Steinberg Media Technologies GmbH Inc. 
• Intel® e Pentium® sono marchi registrati di Intel Corporation. 
• MACKIE Control è marchio registrato di LOUD Technologies. 
• Tutti gli altri marchi, nomi di prodotti e di compagnie menzionati in questo documento sono di proprietà 
dei rispettivi detentori.

Nell'interesse del miglioramento del prodotto, le specifiche possono variare senza obbligo di preavviso.
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Collegare e scollegare in modalità interfaccia audio
veduta d’insieme su come collegare e scollegare R24 e un computer usando un cavo 
USB . Per dettagli, fate riferimento a alla “Cubase LE Startup Guide” . 

Collegare R24 a un computer per la 
prima volta

Installate il software DAW di 
Cubase LE sul computer.1 1 Premete USB.

Installate il driver audio sul 
computer usando l’accluso  
CD-ROM.

2

Premete ENTER. 

Selezionate AUDIO I/F.  2

Premete ENTER.

Selezionate EXECUTE.  3

☞ Riferimento: “Cubase LE Startup Guide” 

Dettagli di installazione e setup

R24: setup e collegamento

Collegate R24 al computer.4

R24: setup e collegamento 
Seguite queste procedure dalla seconda connessione in poi

 NOTE
• Il driver audio per R16/R24 di ZOOM è essenziale 

per usare R24 come interfaccia audio con un 
software DAW come Cubase LE. 

 Eseguendo i l  download, seguite la guida 
a l l ’ i ns ta l l az ione  acc lusa  per  ins ta l l a r lo 
correttamente.

• Scaricate il driver audio più recente di R24 dal 
sito web di Zoom Corporation.

 http://www.zoom.co.jp/

Setup dell’apparecchio

Setup superficie di controllo P.7

Setup del software DAW.5
☞ Riferimento: “Cubase LE Startup Guide”

Cambia 
menu

Cambia 
menu

Mackie Control
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1

• L’interfaccia audio e le funzioni di superficie di 
controllo di R24 possono essere usate portando 
alimentazione tramite USB bus. 

• Consigliamo di usare sempre il software di 
sistema più recente di R24. 

• Con alimentazione phantom, consigliamo di 
usare batterie o un adattatore AC anche se l’unità 
è usata come interfaccia audio.

Premete   sotto 

Premete ENTER.

Selezionate YES.2

Scollegate il cavo USB3

L’indicatore USB DEVICE si accende

Collegate il cavo USB a R24.4

Collegate il cavo USB al computer.5

L’icona USB appare a connessione completata .

NOTE

Scollegare

Selezionate CONTINUE per usare le stesse impostazioni 
dell’ultima volta.
• Impostazioni INSERT EFFECT

• Impostazioni SEND RETURN EFFECT  

• Impostazioni del mixer 

• Impostazioni TUNER 

Selezionate RESET per riportare alle impostazioni di default 
ogni voce.

Cambia 
menu

or .
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Usare le funzioni della superficie di controllo 
Usando R24 come interfaccia audio collegato tramite USB, i tasti e i fader possono essere 
usati per controllare il trasporto di Cubase LE e il mixer.

 SUGGERIMENTI
Assegnazione dei tasti
Per l’elenco delle funzioni assegnabili a manopole e 
tasti di R24, così come altri tasti trasporto/funzione 
supportati da Cubase LE, consultate la “Guida 
rapida delle funzioni della modalità superficie di 
controllo” di questo manuale.

La superficie di controllo Setup della superficie di controllo

In modalità superficie di controllo, tasti e 
manopole di R24 possono essere assegnati a 
particolari funzioni di Cubase LE .

6 Poi, lanciate Cubase LE.

Sezione trasporto  P.8

I  bank  P.9

Sezione fader  P.9

☞ Ref.: Guida rapida delle funzioni della modalità
 superficie di controllo P.12

7 Dal menu “Devices” di Cubase LE, 
selezionate “Device setup…” 

8 In alto a sinistra nella finestra di 
Device setup appaiono i pulsanti 
[+], [−] e [|<]. Cliccate su [+] e 
selezionate “Mackie Control”.

9 Impostate ingresso e uscita MIDI

Ingresso MIDI: ZOOM R16_R24 
Uscita MIDI: ZOOM R16_R24 

Vd . R24: setup e collegamenti, ai punti 1–5 o P5~6

  SUGGERIMENTI
Il display del MENU ecc  potrebbe variare in 
base alla versione di Cubase LE 
Fate riferimento al manuale di Cubase LE 
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Sezione trasporto 

Impostando la superficie di controllo, i tasti 
della sezione trasporto di R24 possono essere 
assegnati a funzioni specifiche in Cubase LE.

tasto［REW］   tasto［FF］  tasto［STOP］   tasto［PLAY］   tasto［REC］  

tasto［F1］  tasto［F5］  tasto［F2］  tasto［F3］ tasto［F4］ 
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Operatività della sezione fader 
Usando i fader e i tasti di status della sezione fader, potete regolare il volume delle 
tracce corrispondenti di Cubase LE, metterle in mute o assolo e abilitarle per la 
registrazione .

Usare la sezione fader

1 Assegnate alla sezione fader le 
tracce (canali) di Cubase LE che 
volete controllare.

I bank 

Dopo aver attivato l’operatività superficie di 
controllo, i parametri principali di Cubase LE 
possono essere usati usando i fader e i tasti di 
status di R24.

Un gruppo di tracce attivate dai fader e dai 
tasti di status è detto “bank”. Con R24, è 
possibile controllare un bank composto da 8 
tracce adiacenti.
Ad esempio, se il fader 1 è assegnato alla trac-
cia 1 di Cubase LE, le tracce 1-8 possono es-
sere controllate come illustrato nel diagramma.

Controllo 1 2 3 4 5 6 7 8
Traccia Tr 1 Tr 2 Tr 3 Tr 4 Tr 5 Tr 6 Tr 7 Tr 8

Come mostra il diagramma, , selezionando le 
tracce 1~8, premendo una volta il tasto [9~16tr 
(Bank>)] si commutano le assegnazioni come 
illustrato sotto.

Controllo 1 2 3 4 5 6 7 8
Traccia Tr 9 Tr 10 Tr 11 Tr 12 Tr 13 Tr 14 Tr 15 Tr 16

Tasto 1~8Tr (< BANK) 
Le tracce (canali) assegnati alla sezione fader si 
spostano indietro di otto tracce. 

Tasto 9~16Tr (BANK >) 
Le tracce (canali) assegnati alla sezione fader si 
spostano in avanti di otto tracce.

2 Usate i fader per controllare i 
volumi delle tracce corrispondenti.

I fader controllano i volumi delle rispettive 
tracce. Variate il volume master usando il 
fader [Master].

3 Per variare la funzione dei tasti di 
status per tutte le tracce, premete 
il tasto relativo alla funzione 
desiderata.
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Indicatori di livello di R24 
(uso come interfaccia audio)

Ogni indicatore di livello 
diverso da MASTER 
mostra il segnale 
immediatamente prima di 
inviarlo al computer.

L’indicatore di livello 
master mostra il 
segnale di ritorno dal 
computer.

Controllare i livelli di registrazione DAW 
Impostate “REC SIGNAL” (nel menu 
INSERT EFFECT) su “WET” (segnale 
con effetti) o “DRY” (nessun effetto) per 
inviare segnali processati o meno dagli 
effetti inserti al computer.
I livelli di registrazione dei segnali inviati sono 
visualizzati sugli indicatori di livello. Il segnale 
mostrato sull'indicatore di livello master differ-
isce da quello mostrato su ogni indicatore.

Regolate i livelli in modo che 
gli indicatori di clip rossi (0 
dB) non si accendano.

Luce 
rossa 
(clip)
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Impostazione dei tasti funzione
I cinque tasti posti sopra quelli di trasporto possono essere usati come tasti funzione 
(F1~F5) e assegnati a piacimento .

Setup dei tasti funzione

51 Aprite il box di dialogo “Device 
setup…” in Cubase LE.

7 Premete il pulsante “Apply”. 

Scegliete il tipo di funzione di 
Cubase LE dal menu pop-up 
Category. 

2
I comandi possono essere assegnati usando le 
tre colonne visibili a destra della finestra .

Selezionate “Mackie Control”.

3 Dalla colonna “Button” scegliete 
il tasto funzione (F1~F5) da 
assegnare alla funzione di Cubase 
LE.

6 Cliccate sulla colonna “Command” 
e selezionate la funzione di Cubase 
LE dal menu pop-up.

Le voci di questo menu pop-up varieranno in 
base alla categoria prescelta .

4 Cliccate sulla colonna “Category” 
relativa a quel controllo.   SUGGERIMENTI

Il display del MENU ecc  potrebbe variare in 
base alla versione di Cubase LE 
Fate riferimento al manuale di Cubase LE 
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Guida rapida delle funzioni della modalità superficie di controllo

Controllo Spiegazione

Sezione fader 

Tasto status Attiva/disattiva mute, assolo o registrazione abilitata su traccia

Fader Controlla il volume delle tracce corrispondenti

Fader MASTER Operatività del volume Master 

Sezione display Tasti morbidi
Commutano le funzioni dei tasti di status/Terminano la 
connessione (EXIT)

Sezione trasporto 

Cursori
Eseguono le stesse funzioni delle frecce della tastiera del 

computer

MANOPOLA Sposta la posizione del cursore

Tasto REW Riavvolge

Tasto FF Avanti veloce

Tasto STOP Stop

Tasto PLAY Play

Tasto REC Registra

Tasto AUTO PUNCH I/O Dipende dall’impostazione del tasto [F1]

Tasto A-B REPEAT Dipende dall’impostazione del tasto [F2]

Tasto  (marker)  Dipende dall’impostazione del tasto [F3]

Tasto  (marker) Dipende dall’impostazione del tasto [F4]

Tasto MARK/CLEAR Dipende dall’impostazione del tasto [F5] 

Sezione controllo 

Tasto 1-8Tr Avanza di un bank

Tasto 9-16Tr Arretra di un bank
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Usare i file template di Cubase LE

Creare un nuovo project

Copiate i project template di R24 di  
ZOOM sul computer.1

2 Lanciate Cubase LE e selezionate 
File > New Project.
A seconda delle singole 
impostazioni, si apre o la finestra 
di dialogo di Steinberg Hub o di 
Project Assistant.

Windows
La cartella aperta cliccando su  Start>Steinberg 
Cubase LE XX>User Settings Data Folder
Macintosh
/Applications/CubaseLE XX.app/Contents/
templates/

Dalla cartella di CubaseLE5_template sul CD 
accluso a R24, copiate i template nel punto in 
cui Cubase LE è stato installato .

3 Create a new project
Dopo aver copiato i project template di R24 
sulla cartella designata, i project template di 
R24 saranno visualizzati quando si crea un 
nuovo project .
Scegliendo questi template potrete creare 
facilmente project con ingresso traccia audio e 
impostazioni in uscita adatte a R24.

Template: nomi e dettagli

ZOOM R16_R24 Registrazione 8Mono

Project con Cubase LE tracce mono 1~8 
assegnate a R24 INPUTS 1~8

ZOOM R16_R24 Registrazione 4Stereo

Project con Cubase LE tracce stereo 1~4 
assegnate a R24 INPUTS 1/2 ~ 7/8

ZOOM R16_R24 Registrazione 4Mono 

2Stereo

Project con Cubase LE tracce mono 1~4 
assegnate a R24 INPUTS 1~4 e Cubase LE tracce 
stereo 5~6 assegnate a R24 INPUTS 5/6 e INPUTS 
7/8

Consigli per migliorare la 
performance

U s a n d o  C u b a s e  L E ,  l e  a z i o n i 
dell’applicazione potrebbero risultare es-
tremamente ritardate o potrebbero apparire 
dei messaggi d’errore come “cannot syn-
chronize with USB audio interface/impos-
sibile sincronizzare con interfaccia audio 
USB”. In caso ciò si verificasse di frequente, 
prendere le seguenti misure potrebbe aiutare 
a migliorare la situazione.

➊ Terminate gli altri programmi 
in corso a eccezione di 

Cubase LE .
In particolare, verificate che non vi siano 
molte applicazioni in background.

➋ Riducete l’uso di plug-in 
(effetti, generatori di suono)

Se vi sono molti plug-in operativi, il  com-
puter potrebbe essere in difficoltà. Inoltre, 
potrebbe essere utile ridurre il numero di 
tracce in riproduzione simultanea.

➌ Usate l’adattatore AC di R24
Quando gli apparecchi derivano la loro 
alimentazione da USB bus, in rari casi la 
performance del computer potrebbe soffrire. 
Provate usando l'adattatore AC.

Se il suono si interrompe, aumentate la di-
mensione del buffer audio nel menu Device 
Setup... > VST Audio System.
Inoltre, se la performance dell'applicazione è 
estremamente bassa e la normale operatività 
del computer è intaccata, vi consigliamo di 
chiudere Cubase LE e scollegare la porta 
USB di R24 dal computer una volta, e poi 
ricollegare la porta USB e rilanciare Cubase 
LE.

“XX” varia in base alla versione installata.
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Il mixer in modalità interfaccia audio 
In modalità interfaccia audio potete effettuare il mix per il monitoraggio usando il mixer 
interno di R24 . Inoltre, potete regolare il bilanciamento tra mixer interno e suono del 
computer .

NOTE
L e  i m p o s t a z i o n i  d i  r e v e r b 
s e n d ,  p a n ,  v o l u m e  e  s t e r e o  l i n k  
s o n o  s a l v a t e  q u a n d o  t e r m i n a t e  l a  m o -
d a l i t à  i n t e r f a c c i a  a u d i o  ( E X I T )  
e possono essere usate ancora la volta successiva.

Potete regolare le impostazioni di REVERB 
SEND, PAN, VOLUME e STEREO LINK come 
in modalità registrazione.
L’operatività è la stessa della modalità registrazione .
(Ref .: MANUALE OPERATIVO)

Menu PAN/EQ

VOLUME 
Regolate i volumi di INPUTS 1~8.

0~127 (incrementi di 1) 
Valore di default: 100

REV SEND
Regolate i livelli reverb send di INPUTS 1~8.

0~100 (incrementi di 1)
Valore di default: 0
Reverb influisce solo 
sul segnale monitoratol 
(come in modalità 
registrazione) .

PAN (BALANCE)
Regolate il pan INPUTS 1~8.

L100~R100  
(incrementi di 2)
Valore di default: : Centro
(come in modalità 
registrazione) .

Linkate gli INPUT pari e dispari per gestirli come 
coppie stereo.

On/Off
Impostazione di default: Off
Impostando uno stereo link, i parametri di traccia di  
volume, reverb send e pan possono essere applicati a 
coppie di ingressi pari e dispari contemporaneamente 
(come in modalità registrazione) .
(Ref .: Manuale Operativo)

Volume, reverb send, pan

Manopola Balance

In modalità interfaccia audio, il bilanciamento 
dei segnali monitorati dagli input e dai segnali 
di ritorno dal software DAW (computer) pos-
sono essere regolati con la manopola BALANCE. 

Stereo link

Sinistra
Solo segnali 

INPUT 1~8

Destra
Solo segnale stereo 
DAW
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Accordatore 
L’accordatore di R24 può essere usato allo stesso modo della modalità di registrazione . 
Per ulteriori dettagli consultate il Manuale Operativo . 

1 Premete TOOL. 

Selezionate TUNER. 2

Premete 
ENTER.

Premete ENTER.

Accordatore cromatico 
TOOL > TUNER

4 Per cambiare la tonalità di base, 
premete  sotto .

5 Selezionate la tonalità di base.

NOTE
Le impostazioni dell’accordatore sono salvate quan-
do terminate la modalità interfaccia audio (EXIT)  
e possono essere usate ancora la volta successiva.

SUGGERIMENTI
• La tonalità base di default è 440 Hz. 
• Si possono usare accordatori diversi da quello 

cromatico. 
 (Ref.: Manuale Operativo )

☞ Ref.: Manuale Operativo 
  Accordatore 

Cambia 
menu

Cambia la 
tonalità di base

Premete ENTER.

4 Per cambiare tipo d’accordatore, 
premete  sotto .

5 Cambiate tipo d’accordatore.

Cambia tipo 
d’accordatore

3 Accordate lo strumento.
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Effetti in modalità interfaccia audio
Gli effetti insert e send-return di R24 possono essere entrambi usati quando la 
lunghezza dell’onda di campionamento è impostata su 44 .1 kHz . L’operatività di base è 
la stessa, ma vi sono alcune differenze nei menu .

NOTE
• Gli effetti possono essere usati sono se il livello 

di campionamento è 44.1 kHz.  In ogni altro caso 
è su OFF.

• Le impostazioni dell’effetto insert e send return 
salvate quando terminate la modalità interfaccia 
audio (EXIT) e possono essere usate ancora la 
volta successiva. 

Effetto Insert Effetto Send Return 

Come in modalità registrazione, selezionate il 
punto di inserimento e l’algoritmo dell’effetto 
insert, così come le patch effetto da applicare 
al segnale di registrazione.

Menu  EFFETTO INSERT  

Selezionate il punto di inserimento
Potete impostarlo per ogni INPUT 1~8.

(Ref : Manuale Operativo )

Applicare l’effetto al solo monitoraggio
L’effetto può essere impostato in modo che sia applicato 
solo al segnale in monitoraggio e che non influisca sui 
segnali registrati con software DAW .

(Ref .: Manuale Operativo )

Come in modalità registrazione, potete usare il 
menu SEND REVERB per cambiare la patch 
e il menu PAN/EQ per impostare il livello di 
mandata REV SEND che regola la profondità 
del segnale di reverb.

Impostare il livello di reverb send

REVERB SEND
Regolate la quantità di riverbero usando il liv-
ello REV SEND del menu PAN/EQ. 

(Ref .: Manuale Operativo )
(Ref .: Manuale Interfaccia Audio – Mixer )
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Lavorare con le patch
Dopo aver effettuato cambiamenti, potete riportare la patch alle impostazioni 
precedenti gli editing effettuati inizializzandola . Questo riporterà alle condizioni 
presettate .

1 Premete EFFECT.

Attivare/disattivare gli effetti
Effetto Insert

Effetto Send return 

Inizializzare una patch (factory reset)
EFFECT > INITIAL

Selezionare un effetto insert/patch 
reverb
Per usare un effetto insert, selezionate un al-
goritmo e una patch. 
Per usare un effetto send reverb, selezionate 
una patch.
(Ref.: Manuale Operativo )

Editare le patch (EDIT)

Regolando i parametri del modulo effetto e i 
livelli, potete ottenere il risultato desiderato. 
(Ref.: Manuale Operativo )

Importare patch (IMPORT)

Tutti gli algoritmi (e patch reverb) o uno solo 
possono essere importati da un project selezi-
onato su R24. 
(Ref.: Manuale Operativo )

In modalità interfaccia audio, un set completo di 
dati effetto è salvato per la modalità. Non vi sono 
impostazioni basate su project.

Salvare le patch (SAVE)
Le patch editate possono essere salvate.
(Ref.: Manuale Operativo )

Inizializzare le patch (INITIAL)
Riporta le patch alle impostazioni originali di 
fabbrica (disponibile solo in modalità interfac-
cia audio).

Cambiare nome alle patch (RENAME)
Il nome della patch attualmente selezionata 
può essere cambiato.

Menu operatività patch 

Operatività patch
Sia per effetto insert che send return 

L'esempio seguente è relativo a un 
effetto insert. 

Premete  sotto .

Premete  sotto .

Attivate l’effetto scegliendo On.2

Selezionate INITIAL.3

Premete ENTER.

Cambia 
menu

4 Selezionate  YES. 

Premete ENTER. 

Cambia
menu

Cambia



Premete  sotto .

Premete  sotto .

4-4-3 Kandasurugadai, Chiyoda-ku, Tokyo 101-0062 Japan
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Cubase LE　Startup Guide

New audio track
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Install Cubase LE referring to the bundled 
'Download access code sheet'.

Download the latest driver from ZOOM website
(www.zoom.co.jp) and install it. 

Connect the ZOOM unit to the computer.
Please refer to Operation Manual how to connect.

Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio 
system" in the Devices Column.
Select the downloaded driver or the devices including the ZOOM model names here.
e.g. H Series Multi Track is shown as following.

Select "VST Connections" from "Devices" menu and set the input and output device 
ports to the downloaded driver or the devices including the ZOOM model names.
For multi-track supported models, click "Add Bus" and add the input bus.
e.g. H Series Multi Track is shown as following.

Select "New Project" from the "File" menu.

"Project Assistant" window opens in order to select a project template. Click "More", 
select "Empty", and then click the "Create" button to display the project window. 

Select "Add Track">"Audio" from "Project" menu and add new audio track.

Click "Record" button on the Transport panel and start recording.

Recording starts. Click "Stop" button to stop recording.

Click "Play" button to check the recording.

Download access code sheet

This is all for the basic setting.
For more information, please refer to the Documentation from "Help" in Cubase LE  or  
visit Steinberg website （www.steinberg.net/en/home）.

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.
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